MicroSoft Office Tips
Microsoft Word
•

Shortcut Keys – Sheet Attached

•

Highlighting Text:

•

o

To highlight a word – double click on any part of the word.

o

To highlight an entire line - move cursor to the very left of the line – when it turns
into an arrow, click once.

o

To highlight an entire paragraph - move cursor to the very left of any line in the
paragraph – when it turns into an arrow, double click.

o

To highlight an entire document - Hit ‘Ctrl A’

o

To highlight from a certain point in the document, to the end of the document - Start
from the desired location in the document (the beginning of where you want to
highlight), hold the ‘shift’ + ‘ctrl’ and then hit the ‘end’ key.

Tabs
o

To set a manual tab, move your cursor to the area on the horizontal ruler, where
you’d like to place a tab, and click. Remember: word will remove all tabs to the
left of where you’ve designated your new tab(s), but all tabs to the right will
remain in tack. 1

o

When setting tabs, only the area you’ve highlighted will be affected by the new
format. (Unless tabs are set before you begin typing your document)

o

Leader dots (. . . .) can be added to existing tabs.
 First click on the ‘Page Layout’ tab, then hitting the drop arrow by
‘paragraph’, and clicking on ‘tabs’.
 Highlight the tab to where you’d like the leader dots to flow (i.e. if you
have tabs set at 1” and 5” and “5.5, you’d click on 5” so that leader dots
can flow to end of line but gives you space to add in information such as
page numbers behind the dots).


1

Click “set” and then “ok”.

This is only one way. You can also manipulate tabs by going to page layout, click the drop arrow by paragraphs, clicking on
tabs, and working from there.
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•

Tabs (cont’d.)
o

You can format tabs so that they are left aligned

, right aligned , or center

aligned , both to center text, or for typing numbers where you’d like the
decimal points to line up. This can be done when manually inserting tabs by
clicking on the box just to the left of the horizontal ruler, until it displays the
appropriate sign (see above), or by going to “tabs” under page layout, on the
toolbar.
•

Paper Orientation
o

To create more than one orientation within the same document, go to ‘Page
Layout’, click the drop arrow next to ‘Breaks’, there you will see two sections Page Breaks, and Section Breaks. Under Section Breaks, click ‘Next Page.’ This
will not only give you a new page, but will also allow you to change any of the
formatting, including orientation, header and footer information, margins, etc.

•

Working with Headers/Footers
o

Click on ‘Insert’ tab. Click header or footer. You can either select one of the
default headers/footers, or choose ‘edit’ to create your own. You can also remove
headers/footers from this screen.

o

Once you’ve completed your header/footer, you can go back to the document
simply by double clicking outside of the header/footer area, or hitting ‘close
header/footer.’

o

Creating Different Headers/Footers within the same document


When creating a document with different header/footers (this would
include “letterhead” with “second sheets”, documents with different
numbering systems, etc.), you’d need to insert a “Section Break” (see
Orientation above) at the end of the page where your header/footer will
differ. Then click on ‘Insert’, either ‘header’ or ‘footer’ and under the tab
titled ‘Navigation’ click to de-highlight the ‘link to previous’ key.



When creating page numbers, you can choose the type of numbering,
whether or not to include a number on the first page, what number
document should begin with, etc., by going to the header/footer tool bar,
clicking on ‘page number’ and then selecting ‘formatting’.
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•

Working with Mail Merge
o

When creating a mail merge in Word, you can use lists from other Word
documents, Excel, or Access.

o

To create a merge, you select the ‘Mailings’ tab. Click on ‘Step-by-step Mail
Merge Wizard.’


Step One – Select the type of document (letter, labels, e-mail, etc.)



Step Two – Indicate whether you will be using the current document
(recommended you create your letter first, and then begin your mail
merge from within that document) NOTE: If you are merging labels
instead of letters, this step gives you the option to select the type of labels
you’d like to use by clicking “label options.”



Step Three – Select the data list that you will use to merge with your
letter. You do this by clicking on ‘Browse’ and mapping a trail to the
document you’ll be using. NOTE: If using an Excel file, you will be
prompted to indicate which worksheet you would like to use (See Excel –
Worksheets below). Once you’ve selected a worksheet, you will see that
all records in that worksheet will be highlighted, if you’d only like certain
records to be used in the merge, this will give you a chance to choose only
the records you’d like to use.



Step Four – This is where you will add in the fields you’d like to merge
into your letter. If you only want the address, you can just choose the
address block. If there are separate fields you’d like to merge into the
letter, go to the exact spot in the letter that you’d like to merge the
information, click on ‘More Items’ choose the specific field you’d like
included, hit ‘insert”, and then click ‘close.’ Repeat this step for each
additional field you’d like to add. ) NOTE: If you are merging labels
instead of letters, once you’ve selected the fields you’d like to merge
(usually address block) you’d need to also hit “Update all labels.” so
that each label doesn’t duplicate only the first record.



Step Five – Gives you a chance to see what the letter will look like once
the merge is completed. Pay attention to formatting, etc. If there are any
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changes you’d like to see made to each letter that will be merged, this is
where you can make them.


Step Six – Complete the merge. This will give you the option to either
“print” the letters or “edit individual letters.” I would always choose the
edit. Chances are there will be nothing to change, but this will allow you
save the newly merged letters (in case you should need to reprint one or
all without going through the entire merge process again).



NOTE: When using an Excel document for the data list, remember that
the first line can NEVER be blank, and must contain the field names of
the information being merged (i.e. Name, Address, City, State, etc.)

•

Working with Tables
o

Select the ‘Insert’ tab, – click on the ‘Table’ tab, and indicate the number of rows
and columns you’ll need. (Don’t worry if you don’t know how many you’ll need
when you’re creating the table, rows and columns can be added at any time.)

o

You can also choose a design after table has been created. With cursor anywhere
in the table, simple click the Design tab, and choose one of the default designs.

o

Other formatting can be done by doing a “right-click” from within the table and
selecting the appropriate formatting. From here you can alter the look of the
table, add or delete a row or column, resize the width or height of the row or
column, add shading, borders, etc.

o

You can also copy a table from Excel directly into Word by using the copy and
paste function.

•

Quick Tips to Remember
o

When working on multiple documents, use ‘ALT’ + ‘Tab’ to move from one
document to the next. Remember: hold the ‘ALT’ while clicking the ‘Tab’ key
until you get to the document you want. (watch the screen, and an icon will
appear to let you know which document you are about to move to).
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o

To create a new page, hit ‘CTRL’ + ‘Enter’. Do not space down until you get to a
new page, as it will throw off your formatting if the document is edited and new
information is either inserted or deleted.

o

Use headers and/or footers when inserting information you’d like to always be in
a certain position (i.e. letterhead information, page numbers, etc.).

o

When resizing pictures (regardless of the software), remember to pull picture
from either corner, but NEVER from the sides, top, or bottom. This will distort
the picture image.


When trying to fit a picture into a certain size (dimension), you may need
to crop picture before pulling from the corner so that it will fit.

o

By selecting ‘Print Scrn’ (just above the number pad on the keyboard), you can
copy graphics from any software (including the internet), and paste into another.
Then you can use the ‘crop’ feature to cut away any part of the graphics you
don’t need.

o

and paste from one soft , from the Internet too – at the internet page you want to
copy, hit Print Screen key (above number pad on keyboard), open the Office
software, e.g. PowerPoint, select Paste, double click on the graphic, use the crop
feature to crop OUT what you don’t want so you have what you wanted from
the web page

o

To view all formatting made to a document, select ‘Home,’ tab, and click on the
¶ key. This can help you to adjust any erroneous formatting errors.
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Microsoft Excel
•

Worksheet
o

All Excel documents will open with three worksheets which are simply
titled Sheet1, Sheet2, and Sheet3. To rename each worksheet, you’d rightclick on the tab you’d like to change (Sheet1 for instance), click ‘rename’
(which will highlight the tab) and type the new name. Then hit enter to
lock it in.

o

To duplicate an entire worksheet, (Sheet2 for instance), place your cursor
on the tab that says Sheet2, hold the ‘CTRL’ key, and while holding the
Ctrl key, drag it to the desired location. This will create an identical sheet
which will be automatically named Sheet 2 (2). Then you can rename it to
whatever you’d like (using the directions above).

•

Quick Tips to Remember
o

Many of the Short Cut Keys (on the attached shortcut sheet) will work in Excel
too (with the exception those that are asterisked).

o

When using data from an Excel document to complete a Mail Merge, be sure the
very first line of the document is NOT blank, and DOES contain the field names
(i.e. Address, Name, City, State, etc.).

o

Excel comes with a feature that will automatically list words or numbers such as
days of the week, months, numbers, etc., by typing in the first word (i.e.
Monday), and dragging the box down or across to complete the week (or month,
etc.)

o

Remember to watch the size and shape of the cursor as it identifies what function
will be performed: i.e. A cross with arrows on either side, or either end, will
widen or heighten the size of a cell; a fat white cross will highlight a cell(s); a thin
black cross will give a continuous list of the days of the week, month, etc.; a thin
black cross with a smaller cross just above it and to the right will number the
cells (if the smaller cross is not above it, it will only repeat the same number in
the cell), an arrow pointing down a column or across a row highlights that entire
column/row, etc.

Indispensable Assistant Toolkit, June 2010

6

MicroSoft Office Tips
o

The same formula in different rows/columns does not have to be retyped, but
can be repeated by using the normal copy and paste function. The formulas will
automatically adjust to pick up the cell number for the next column/row.

o

If you highlight all the worksheets within a document, any information entered
on one worksheet will automatically appear on the others. For instance, if you
have five worksheets within a document, and you want the title “UMES
BUDGET” to appear on each of the sheets, you can highlight all the sheets, type
the information once, format it as desired, and it will appear on all subsequent
sheets.

o

Remember: Deleting a column (for example, column “A”) DOES NOT
eliminate that particular letter. All information in that column will be deleted,
and then all remaining columns will shift over to the left (meaning column
“B” will then become column “A”, column “C” will become column “B”, and
so on).

o

Remember: It is possible to delete one cell without deleting the entire row or
column.

Microsoft PowerPoint
•

Master Slides
o

Powerpoint has lots of default Master slides, however, you can create your own
(which may be more specific to your presentation) by going to clicking on the
‘View’ tab, then go to ‘Slide Master’ and create the sheet you’d like to use as a
master. Note: It is sometimes easier to create the design you’d like to use on a
regular slide, hit ‘Ctrl A’ to highlight the entire slide, ‘Ctrl C’ to copy it, and then
when you get to the ‘slide master’ hit ‘Ctrl V’ to paste it in. Note: remember that
if you’re using the same picture on ever slide, it should be put onto the master
slide. This way the file isn’t as large and will make it less difficult if it has to be
e-mailed out.

o

When saving a PowerPoint document, you can save it as a “Power Point Show.”
This will make it a much smaller file, also will allow you to share with someone
who either does not have power point, or who may have a different version.
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o

Remember there are great formatting tools within Powerpoint that will allow
you to align different graphics, text boxes, etc., that will rotate the text or
graphics on your document, that will change the color of pictures or create
watermarks that can be used as a background on slides, etc.
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